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Performance Enhancement Functionality in MARS® version 2017.x 
 

1. Keyboard Accelerators 

2. Toggle Buttons 

3. Multi-Threading Capabilities 

a. Export 
b. Convert 
c. Batch Process Tiles 

d. MARS® GeoCalc 
e. Populate Statistics on Tile Scheme 
f. Add Spatial Index 

4. Double-Click on Tile in Tile Scheme 

5. Bookmarks 

a. Save 
b. Visit 
c. Delete 

6. Jump to: 

a. XY Location 
b. Tile 
c. Check Point 

7. Double-Click on Check Points in Report 

8. Display Options 

9. MARS® Task Manager 

10. Undo / Redo Buttons for Hand Editing Use 

11. Add Spatial Index 

12. Fast TIN 

13. ‘Reference Reclass (Closest Distance)’ Tool 

14. Save to Local Option 

a. Export 
b. Batch Process Tiles 

15. Save / Load XML Settings 

a. Export 
b. GeoCalc 
c. Macro Filter/ Batch Process Tiles 
d. Breakline Properties Window 

16. ‘Auto Calculate Virtual Tile Size’ Grid Export Option 

17. Fast, Compressed JPEG 2000 Raster Exports 

a. Flightline Separation 
b. Hillshade 
c. LiDAR Spatial Distribution Verification Grid Tool 
d. LiDAR Raster JPEG 2000 export 
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1. Keyboard Accelerators 

Most functions in MARS® support keyboard shortcuts (hot keys) which speed manipulation and use of the application. 
 

Keyboard Accelerator for the Help File: 

F1 Opens the Help Topics document for MARS® 

 

Common Keyboard Accelerators: 

Ctrl-N New MARS® project (.mpd file). 

Ctrl-O Open MARS® project (.mpd file). Does not open any other type of file. 

Ctrl-S Save MARS® project (.mpd file). 

Q Activate ‘Pan’ tool. 

+ Zoom in by a fixed amount (25%). Use ‘+’ on the regular keys (no ‘Shift’ needed) or number pad. 

- Zoom out by a fixed amount (25%). Use ‘-‘ on the regular keys or number pad. 

Esc   Exit out of any open dialog box. 

T Toggle between viewing LiDAR points and viewing a TIN surface. 

X Toggle on/off LiDAR points.  

O Toggle on/off orthophotography (imagery). 

C Toggle on/off contour lines. 

S Toggle on/off shapefiles. 

M Toggle ‘Measure’ tool on/off. 

I Toggle ‘Inspect’ tool on/off. 

Ctrl-A Allow display of all LiDAR point classifications. 

Ctrl-K Allow display of only the model keypoint classification (8). 

Ctrl-G Allow display of only the ground point classification (2).  

Ctrl-M Allow display of only the ground point and model keypoint classifications (2 and 8). 

Ctrl-E Color points or TIN by elevation. 

Ctrl-I Color points or TIN by intensity. 

Ctrl-C Color points or TIN by classification. 

Ctrl-R Color points or TIN by return. 

Ctrl-L Color points or TIN by collection scan. 

Ctrl-J Color points or TIN by RGB values. 

Ctrl-F   Color points or TIN by imagery RGB values (Color by Imagery Fusion). 

Ctrl-D 
Copy the X, Y (and Z, if available) coordinates values shown at the right side of the Status Bar to 
the Windows clipboard, based on the current cursor location. 

Ctrl-T Toggle Fast TIN on/off. 

Ctrl-Z Undo last vertex drawn or point placed when drawing 2D features from the ‘Vector Creation’ tab. 

Z   Open the 'Elevation Repeat Colors Options' interface. 

 
 
 
 



August 31, 2017 Page 3 

Keyboard Accelerators for Cross-Section/Profile View Manipulation (these options are only available when the 
cross-section/profiling window is open and selected) 
 

W Activate ‘Place Adjustable Cross-Section Line’ tool. 

D Set Depth of the cross-section/profile area. 

Up Arrow () Move the cross-section/profile area forward. 

Down Arrow () Move the cross-section/profile area backward. 

Right Arrow () Rotate the cross-section/profile area clockwise. 

Left Arrow () Rotate the cross-section/profile area counter-clockwise. 

Underscore ( _ ) 
In the Cross-Section/Profile window, toggle between ‘Cross-Section’ and ‘Profile by 
Collection Scan’ views. 

Ctrl-A Allow display of all LiDAR point classifications. 

Ctrl-K Allow display of only the model keypoint classification (8). 

Ctrl-G Allow display of only the ground point classification (2).  

Ctrl-M Allow display of only the ground point and model keypoint classifications (2 and 8). 

Ctrl-E Color points or TIN by elevation. 

Ctrl-I Color points or TIN by intensity. 

Ctrl-C Color points or TIN by classification. 

Ctrl-R Color points or TIN by return. 

Ctrl-L  Color points or TIN by collection scan. 

R 
  Activate the 'Rotate Profile' window and allow the user to rotate the cross-section/profile area 

a specified number of degrees. 

 

Keyboard Accelerators for Point Editing in the LAS Map View Window 

0-9 
Modify the currently selected points to the new classification indicated by the number key pressed. 
For example, the ‘5’ key modifies selected points to the point classification ‘High Vegetation’. 

G 
Activate the 'Edit Place Polygon' tool, which selects all points within the boundary of the user's 
manually defined polygon. 

Space 
Modify the currently selected points to the last target classification used. For example, if the last 
classification edited had a value of 6, then pressing the space bar will modify the currently selected 
points to the same target classification, 6. 

U Unselect all currently selected points. 

Ctrl-P Activate the small paintbrush tool for selecting points. 

P Activate the medium paintbrush tool for selecting points. 

Shift-P Activate the large paintbrush tool for selecting points. 

E Activate ‘Filter Region’ tool. 

Esc  Leave the current editing mode. 

Ctrl-Z Undo the last edit step. 

Ctrl-Y Redo an edit step. 

Z    Open the 'Elevation Repeat Colors Options' interface. 
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Keyboard Accelerators for Point Editing in the Cross-Section/Profile Window 

0-9 
Modify the currently selected points to the new classification indicated by the number key pressed. For 
example, the ‘5’ key modifies selected points to the point classification ‘High Vegetation’. 

Space  
Modify the currently selected points to the last target classification used. For example, if the last 
classification edited had a value of 6, then pressing the space bar will modify the currently selected points 
to the same target classification, 6. 

U  Unselect all the currently selected points. 

/ Activate the 'Edit Scrape Above' tool. 

? Activate the 'Edit Scrape Below' tool. 

S Activate the 'Line String Above' tool, which selects all points above a manually defined line string. 

Shift-S Activate the 'Line String Below' tool, which selects all points below a manually defined line string. 

Ctrl-P Activate the small paintbrush tool for selecting points. 

P Activate the medium paintbrush tool for selecting points. 

Shift-P Activate the large paintbrush tool for selecting points. 

Esc Leave the current editing mode. 

Ctrl-Z Undo the last edit step. 

Ctrl-Y Redo an edit step. 

D   Open the 'Set Cut Depth' window to adjust the cut area depth of the cross-section/profile tool. 

Z Open the 'Elevation Repeat Colors Options' interface. 

R 
  Activate the 'Rotate Profile' window and allow the user to rotate the cross-section/profiling area a 
specified number of degrees. 

 

Keyboard Accelerators for Breakline Editing in the LAS Map View Window 

Esc Leave the current editing mode or dialog window. 

Shift-Mouse 
Click 

Holding down the shift key while compiling breaklines will cause the breakline to snap to the user-
designated point. The point to which the breakline will be snapped will be determined by the feature 
drop-down code list. Choose either: 'startendvertex', 'vertex', 'nearestpoint', or 'midpoint'. 

Ctrl-Mouse 
Click 

Ctrl-Click on a breakline the first time will collect that breakline's Z-value, and Ctrl-Click a second time 
will transfer that collected Z-value to a new breakline point that is currently being compiled. 

B Toggle on/off the auto-pan mode. 

Alt 
Holding the 'Alt' key down while in collection mode will allow the user to pan across the data when 
auto-pan is turned off. The cursor will temporarily turn from collection tool to pan tool while the 'Alt' key 
is pressed.  

Ctrl-B Toggle display of breaklines on/off. 

Ctrl-T Toggle Fast TIN on/off. 

Ctrl-Z Undo last vertex drawn when placing a breakline. 
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Keyboard Accelerators for Editing Point Classes 

 

 If the user wants the ability to enter a number for any class (0-9, 10-99, or 100-999), go to the 'Options Tab’ and click the 

‘Miscellaneous' button. In the upper-right corner of this window is the 'Editing Options' section. Check the box labeled 

'Enable two or three digit class keyboard input'. This option allows the user to use 2 or 3 digit classes when using the 

keyboard accelerators in editing. If LiDAR data contains classes with 2 or 3 digits, this option can be useful during editing. 

Simply enter the 2- or 3-digit class, choose 'Enter' on the keyboard, and any LiDAR points highlighted will be changed to 

the classification entered by the user. It is also possible to enter 1-digit classes while the 'Enable two or three digit class 

keyboard input' option is checked by choosing 'Enter' on the keyboard after the number. The points will then be 

reclassified. When the  'Enable two or three digit class keyboard input' option is unchecked, points selected cannot be 

reclassified to a 2 or 3 digit classes because as soon as one number is entered (interpreted by MARS® as a 1-digit class) 

the points are automatically reclassified without hitting the 'Enter' key. For example, the user can select LiDAR points 

needing to be reclassified and enter ‘15’ if that is the intended destination class. Without the 'Enable two or three digit 

class keyboard input' option chosen, the points selected will be reclassified to class 1 because this was the first number 

entered on the keyboard to reclassify data. To reclass selected LiDAR points to a class with 2 or 3 digits using the 

keyboard accelerators, choose the 'Enable two or three digit class keyboard input' option, select the points to be 

reclassified, enter the class number, and choose 'Enter' on the keyboard. See the 'Miscellaneous Options’ window below. 

 

 
 
 

 



August 31, 2017 Page 6 

2. Toggle Buttons: 
The toggle buttons found on the View Tab on the MARS® main screen provide easy access for control of the display. Not 

all toggle buttons available on the tab speed up the performance and functionality of MARS®, so some have not been 

included here. 

 

The View Tab: 

    

 
 
 
 

 Color by Elevation: Displays LiDAR points rendered by elevation. 

 Color by Intensity: Displays LiDAR points rendered by intensity value. 

 Color by Classification: Displays LiDAR points rendered by classification. 

 Color by Return: Displays LiDAR points rendered by return value. 

 Color by Collection Scan: Displays LiDAR points rendered by collection scan. 

 Color by Ground Color: Displays user-defined ground class(es) by RGB values and all other points by 

classification. (Must have imagery loaded for this option to become available.) 

 Color by RGB: Temporarily fuses the color from an ortho image to the LiDAR points for display purposes.  

 Color by Imagery (Fusion): Drapes imagery over the LiDAR points. (Must have imagery loaded to be enabled) 

 Blend with Intensity: Blends Intensity values with any other method (e.g., Elevation, Classification, Return, etc.) 

 Color by Hillshade: This tool colors an elevation float grid by hillshade on the fly. It is only available if one or more 

float grids have been loaded in MARS® and can be used in 3D in conjunction with a float grid (*.flt) file. 

 Color by Z Delta: This tool will color the points in the LiDAR data by the vertical difference in flight lines.  

 Color by AGC (LAS 1.0): Displays LiDAR points rendered by auto-gain control value at the time the particular point 

in question was acquired in the system. The AGC value tells the user how the system was attempting to center the 

intensity histogram at the time of collection. 

 Bit Flag: This tool brings up the ‘Bit Flag Display Settings’ interface which allows display control of LAS v1.4 

points based on several bit flag settings – Synthetic, Model Key-point, Withheld, Overlap, Edge of Collection Scan, 

Scanner Channel, and Scan Direction.  

Points: Display LiDAR data as points. Also known as a ‘point cloud’ display. 

TIN: Display LiDAR data as a TINned surface.  
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3. Multi-Threading Capabilities 

 a. Export: 
A multi-threading tool may be found in the MARS® Export utility. It is available for use with most export types, and it 

functions to speed up export by using a specified amount of a computer’s CPU processing power. The multi-threading 

options can be found at the bottom of the export interface in the right hand corner. Initially, the box will show the 

maximum number of threads available for processing. Leave as is, or enter the desired number of threads to use in 

processing here. If ‘1’ is typed inside this text box, it is equivalent to single-threading the process. Ideally, there should be 

a minimum of three (3) GB of RAM available (not just installed) per thread for best performance.  

 

 

 
b. Convert: 

A multi-threading tool may also be found in the MARS® Convert utility. The multi-threading tool in this utility functions 

similarly to the one in the export utility; it will speed up convert by using a specified amount of a computer’s CPU 

processing power. The multi-threading options can be found on the right side of the convert interface. Initially, the box 

will show the maximum number of threads available for processing. Leave as is, or enter the desired number of threads 

to use in processing here. If ‘1’ is typed inside this text box, it is equivalent to single-threading the process. Ideally, there 

should be a minimum of three (3) GB of RAM available (not just installed) per thread for best performance. 

 

 

 

c. Batch Process Tiles: 
The multi-thread function is also found in the Batch Process Tiles tool. Utilizing the multi-thread tool with batch 

processing allows the user to filter very large LAS datasets quickly by dividing the work among multiple threads. Each 

thread designated will process a batch script step on a single tile at a time when used in the Batch Process Tiles 

interface. (ex. Using four threads will run the script on four tiles at a time). The multi-thread function can be found in the 

lower right corner of the Batch Process Tiles interface as shown in the screen shot below. Initially, the box will show ‘1’ 

thread. Leave as is, or enter the desired number of threads to use in processing in the text box. Ideally, there should be a 

minimum of three (3) GB of RAM available (not just installed) per thread for best performance. 
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d. MARS® GeoCalc: 

The MARS® GeoCalc tool (found on the Coordinate Conversion Tab) allows the user to transform LAS data to different 

horizontal coordinate systems and/or horizontal and vertical datums. This tool is also capable of multi-threading to make 

processing faster. The user may choose to use the multi-threading option by checking the ‘Multi-thread’ check box. When 

the multi-thread check box is checked, the 'Number of threads to use' text box is populated with the total number of 

threads on the user's computer. The user can specify to use any number of threads from 2 to the maximum number 

available. Specifying only one thread is equivalent to ‘single-thread’ processing. Ideally, there should be a minimum of 

three (3) GB of RAM available (not just installed) per thread for best performance.  
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e. Populate Statistics on Tile Scheme: 

This tool is located on the ‘Analysis Tab’. Using this tool will create a new shapefile in the same folder as the input tile 

scheme, and it will contain newly calculated attribute fields for first returns, area, average GSD (ground sample distance), 

point density (points per square unit), and many other items. The new shapefile will have the same name as the original 

shapefile except added onto the end of the file name will be  ‘…_With_LAS_Statistics’. The original shapefile will not be 

overwritten. Once the user has run the ‘Populate Statistics on Tile Scheme’ option, the newly created shapefile will need 

to be loaded to MARS® - it will not be added automatically. The user would run ‘Populate Statistics on Tile Scheme’ if 

these attribute fields were needed in an already existing shapefile.  Multi-threading the process will speed up the time it 

takes to calculate the above mentioned statistics and create a new tile shapefile. Ideally, there should be a minimum of 

three (3) GB of RAM available (not just installed) per thread for best performance. 
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f. Add Spatial Index: 

‘Add Spatial Index’ (found on the Project/Data Preparation Tab) is capable of multi-threading the spatial indexing or 

removal of spatial indexing process. To multi-thread (which may shorten the processing time), enter the desired number of 

threads up to the maximum available for the computer. Ideally, there should be a minimum of three (3) GB of RAM 

available (not just installed) per thread for best performance. Multi-threading the Spatial Indexing functions across a USB 

2.0 connection is not recommended as the intensive file reads/writes (disk I/O) may cause hangs or slower overall 

performance than single-threading.  USB 3.0 can be used, but may be limited in performance depending on the speed 

(spin rate) of the external drive. 
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4. Double-Click on Tile in Tile Scheme: 
In order to use this particular shortcut - which will speed processes such as hand editing - a tile shapefile or tile scheme 

must be loaded into MARS®. Once a tile shapefile is loaded, the user can zoom to the extents of a single tile by double- 

clicking inside that tile’s (or polygon’s) extents, if the ‘Double-click to zoom to tile extent’ box is checked in the ‘Viewing’ 

section of Options  Miscellaneous. 

 

 
5. Bookmarks: 

A bookmark can be used to mark a certain place in the data and makes revisiting that same place easier and faster. By 

saving a bookmark, the user will be able to click on the bookmark name in the future and be taken to the place in the 

data that the particular bookmark was placed. Bookmarks are convenient when editing to be able to pick up editing in a 

particular spot, or to save a place where rework needs to be done. The bookmark tools can be found on the Navigation 

Tab. 
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a. Save: 
To create or save a bookmark for future reference, choose this option. The user will be shown a Bookmark Creation GUI 

to name and save the bookmark. Bookmarks are saved with an MPD (MARS Project Document). 

 

 

b. Visit: 
To visit a saved bookmark, use this option. A list of saved bookmarks will appear. Choose the desired bookmark and click 

'OK' to view the bookmark placement.  

 

 

c. Delete: 
To delete a saved bookmark, use this option. A list of all saved bookmarks will appear. Simply choose the bookmark to be 

deleted by highlighting it and clicking 'Delete' at the bottom of the window. 
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6. Jump to 
MARS® provides three methods to quickly navigate to a specific area-of-interest, as described below: 

 

a. XY Location: 
The ‘Jump to XY’ button on the Navigation Tab allows the user to navigate to a specific X, Y coordinate.  

 
 

b. Tile: 
The ‘Jump to Tile’ button on the Navigation Tab allows the user to navigate to the extent of a specific tile by using a 

unique field value. In order to use this tool, a tile shapefile (*.shp) must be loaded into MARS®. 
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c. Check Point: 
The ‘Jump to Check Point’ button on the Navigation Tab allows the user to navigate to a specific check point location. In 

order to use this tool, a check points file (*.csv) must be loaded into MARS®. 

 

 

 

 
7. Double-Click on Check Points in Report: 

In order to use this particular shortcut, which may speed processes in QA/QC, a check points file (*.csv) must be loaded 

into MARS® along with the corresponding LiDAR data. Once the required data is loaded, the user can zoom to specific 

check points by double-clicking on them in the check point report. To run a check point report, make sure both the LiDAR 

data and corresponding check points file are loaded into MARS®, then go to the QA/QC Tab and click the ‘Check Point 

Report’ button. Choose the classes on which to run the check point report, the elevation calculation method, and the 

vertical units of the loaded LiDAR data.  Click ‘OK’ and the report interface will appear.  In the ‘Statistics per Check Point 

(in data units)’ section of the report, choose a check point and double-click on the check point ID; MARS® will zoom to 

that selected check point in the LAS Map View window. 

 
 

 
8. Display Options 

The 'Display Options' interface (Options Tab, Display button) is meant for use with LiDAR data and the Color by 

Elevation tool (on the View Tab) and allows the user to choose custom display options which best fit their needs. This 

GUI may be used to prevent color skewing, which may occur when a small quantity of point values do not match values 

which are popular among the majority of points being displayed and increase the performance capabilities inside 

MARS®. The display options allow the user to apply histogram clipping and stretching, as well as standard deviation 

stretching so that the resulting display is the most correct. There are three (3) separate methods available to the user. If 

the user wishes to make any of the custom settings the new default settings, simply choose the 'Make Default' button 

and these custom settings will be saved and available to the user the next time the 'Display Options' window is opened, 

even in a new session of MARS®. 
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1. Minimum/ Maximum: With this option, the user may specify a minimum and maximum color range stretch for a 

histogram. 

2. Standard Deviation: With this option, the user may specify a number of sigmas to include in the display for both the 

left and right hand sides of a standard bell curve for a standard deviation stretch.  

3. Histogram: With this option, the user may specify a percentage cut-off for both the left and right hand sides of a 

histogram clip. 

1.              2.             3. 

          
 
 

 
9. MARS ® Task Manager: 

The MARS® Task Manager button is located on the ‘Tools Tab’.  
 

The task manager will allow the user to monitor and/or end multiple MARS® processes at once. To end a process, 

highlight it and it will appear in the 'Process Name to End' text box. Click on the 'End Process' button to end the chosen 

process. Note, however, that the session (instance) of MARS® that is running the MARS® Task Manager cannot be 

ended this way.  The 'Refresh' button allows the user to refresh the 'MARS® Task Manager' without closing and re-

opening the tool – ending a process will cause an automatic refresh. 
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10. Undo/Redo Buttons for Hand Editing Use 

  These buttons (on the Edit/Filter Tab) allow the user to undo/redo manual edits made in the profiling window or 

the main window.  Having this capability in MARS® can dramatically increase the efficiency and accuracy of hand 

filtering data.  

 
 

11. Add Spatial Index 
This tool creates a spatial index on one or more LAS files to enable MARS® to read and display the LAS data. It can 

both add spatial indices and remove spatial indices). There are two ways to use Add Spatial Index: 

 

1) Add LAS files to MARS® 

If data without the necessary spatial indexing is among the files selected to be loaded into MARS®, the 

user will be provided a list of those files and three options for handing them: 
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a) Choosing 'Spatially Index LAS Files and Add Them to Project' will permanently prepare the data (by modifying the file 

header) for viewing. This process may be multi-threaded by entering a number greater than 1 in the 'Number of threads to 

use' text box before clicking the ‘Spatially Index…’ button. Ideally, there should be a minimum of three (3) GB of RAM 

available (not just installed) per thread for best performance.  A second window will appear with options for File Source 

and Point Source ID numbering. 
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Depending on the user's preference or requirements, the files can be sequentially renumbered (in the 

order listed in the original window) by choosing the 'Assign collection scan numbers to all files' radio 

button and entering a starting number, or they can be indexed with no changes to any collection scan 

numbering they already have by choosing the 'Retain existing collection scan numbering for all files' radio 

button.  The 'Retain' option is the default.  Please read the method descriptions and caution 

statement before proceeding.  

 

If using the 'Assign' option, please note that LAS version 1.0 files are limited to collection scan numbers of 

1 to 255, while LAS versions 1.1 and later can have collection scan numbers of 1 to 65,535.  Keep these 

limits and the total number of files in mind when entering a starting number. 
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After the choice has been made, click 'OK' to start the indexing and a status bar window will pop up.  

When complete, the files will be loaded.  

 

b) Choosing 'No Change to LAS Files and Add Them to Project' will temporarily prepare the data for the 

current session of MARS®.  When indexed in this manner, no changes are made to the file header and 

the data will need to be re-indexed (either permanently or temporarily) if it is later loaded into another 

MARS® session. 

 

c) Choosing 'Ignore (Will not Add Them into Project)' will cancel the loading of any files without spatial 

indexing, but will load any previously indexed ones that were part of the original selection. 
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2) Using the ‘Add Spatial Index’ interface - This method will permanently modify the header of LAS files when 

spatial index information is added or removed. 

To bring up the interface, go to the Project/Data Preparation tab and click the ‘Add Spatial Index’ button.  

✓ Navigate to the files to be spatially indexed by clicking on the 'Add' button. Files may be removed from 

the list by highlighting them and clicking on the 'Remove Selected' or 'Remove All' buttons. 

✓ Choose one of the Collection scan options: 

• Incremental: Assigns sequential collection scan numbers to each LAS file in the list to be 

spatially indexed. Using this option will overwrite any existing collection scan numbering in 

the LAS files.  Enter the desired starting number in the 'Starting collection scan number' text 

box, keeping in mind that LAS version 1.0 files are limited to collection scan numbers of 1 to 

255, while LAS versions 1.1 and later can have collection scan numbers of 1 to 65,535.  If 

multi-channel files are being processed, check the 'Group Multi-Channel LAS files (one 

number per group)' box to have the same collection scan number assigned to each file in the 

group.  The tool requires that files in a multi-channel group be named identically 

starting with the letter 'L' except for a unique digit denoting the channel number 

following the mandatory letter 'C' - for example, 'L1-1-140324_A-C1_r.las and 'L1-1-

140324_A-C2_r.las' - for this collection scan numbering method to work. 

• No Assign - Keep the collection scan number of every point: No changes are made to 

collection scan numbering that may exist in the LAS files. This is the default. 

• Set all files to one collection scan number: Assigns only one collection scan number to all 

listed files. This option will overwrite any existing collection scan numbering in the LAS files.  

Enter the desired number in the 'Starting collection scan number' text box, keeping in mind 

that LAS version 1.0 files are limited to collection scan numbers of 1 to 255, while LAS 

versions 1.1 and later can have collection scan numbers of 1 to 65,535. 

✓ Multi-Threading: The 'Add Spatial Index' tool is capable of multi-threading the indexing process. To 

multi-thread (which may shorten the processing time), enter the desired number of threads up to the 

maximum available for the computer. Ideally, there should be a minimum of three (3) GB of RAM 

available (not just installed) per thread for best performance.  Multi-threading the Spatial Indexing 

functions across a USB 2.0 connection is not recommended as the intensive file reads/writes (disk I/O) 

may cause hangs or slower overall performance than single-threading.  USB 3.0 can be used, but may 

be limited in performance depending on the speed (spin rate) of the external drive. 
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✓ Class options: This option allow a second spatial index to be created based on all classes EXCEPT the 

one(s) listed in the 'Majority Classes' box.  Click the 'Select' button to choose the desired majority 

classes.  When one or more of the chosen classes are turned off using the 'View Classification' button, 

performance is increased during display-related operations such as pan and zoom.  In addition, a 

higher percentage of the available point cloud will be displayed for a given window extent.  If more than 

one class was chosen as a majority class during indexing, the performance boost will be highest when 

all majority classes are turned off. 

✓ Click 'Add Spatial Index' to index the data, or 'Remove Spatial Index' to return the data to its original 

state.  Removing spatial index information makes no changes to collection scan numbering. 
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12. Fast TIN: 
The ‘Fast TIN’ option inside MARS® should be used when hand filtering. ‘Fast TIN’ will increase the speed at which 

TINned data can be rendered, especially during pan and zoom operations, and will make editing tasks go faster. 

 

IMPORTANT NOTE:  The ‘Fast TIN’ option should never be used when working with breaklines. Breaklines are purposely 

ignored (to enhance performance) when the ‘Fast TIN’ option is used, and therefore will not have the desired visual effect 

on the ground surface. 

 

To use this option, go to the Options Tab, click the ‘Performance' button, and check the ‘Fast TIN’ box.  ‘Fast TIN’ can 

also be toggled on/off by using the shortcut key combination ‘Ctrl-T.’ 

  
 

 

13. ‘Reference Reclass – Closest Distance’ Tool (available with Production license only): 
This tool, found on the Tools Tab, allows the user to reclassify one set of LAS files (the 'Unclassified' input files) based 

on the classes found in another set of LAS files (the 'Classified' input files), by using various parameters found in the LAS 

files. The tool determines which points will be reclassed based on the LAS points’ recorded time and position. This is a 

special version of the ‘Reference Reclass’ Tool: (1) Time will be used to determine possible candidate points, and (2) X, 

Y, Z will be used to determine the closest candidate point. This tool can process LAS data when the two inputs are in 

different time formats (for example: GPS Week Time and Adjusted GPS Time) because it also takes into account the 

position of an LAS point. 

Classified:  Browse to a folder which contains LAS files that have one or more classifications in each file. These 

files are usually in a tile scheme form, but other files can be used. 

Unclassified:  Browse to a folder which contains one or more files that have all points classified as a single 

default value. These files are usually in collection scan form, but other files can be used. 

Output:  Browse to an output folder to store the results of this LAS classification transfer. This selection choice 

is optional;  if the user does not choose an Output folder, the ‘Unclassified’ input data is overwritten with 

the newly classified data based on this reference reclass function. 

Tile Option: Optionally, the data can be tiled upon completion based on a user-selected polygon shapefile tile 

scheme. 

Class Requirement: Checking this option will allow the tool to use every classification offered in the 'Classified' 

data to reclass points in the 'Unclassified' data.  When unchecked, individual classes can be chosen to 

participate. 

Source Fields That Must Match Reference: This area of the interface gives the user the ability to use the 

values offered from the Classified to the Unclassified LAS files as a reference.  
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Cache Unclassified LAS: Checking this option will cache all of the points specified in the 'Unclassified' input 

path to RAM per file. This will make the tool process more quickly than it would working from two 

separate locations (specified by the 'Classified' and 'Unclassified' input paths) on a network.  

Virtual Tile Size: The user may specify a virtual tile size here. The virtual tile size will identify the size of the area 

which the tool will process at any one time.  Computers with more RAM can process larger areas 

resulting in a shorter time to completion. 

 

 

 

14. Save to Local Option (Temporary Folder) 
a. Export: 

The ‘Save to Local Option’ can be found in the export interface for the following export types: Flightline Separation - JPEG 

2000, both ENVI Grid types, Esri ASCII Grid, Float Grid, IMG Grid, LAS, LAS Grid, TIFF Grid, Hillshade - JPEG 2000, 

LiDAR Spatial Distribution Verification Grid - JPEG 2000, LiDAR Raster JPEG 2000 Grid, LiDAR Point Density – Float 

Grid, and both PLS-CADD Code types. This tool speeds up MARS® by using temporary local disk space during export 

processing, and is typically used when the ‘Output Directory’ is a network location. To use this option during export of one 

of the file types listed above, check the ‘Use temporary local disk space to speed up processing’ check box and 
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designate a temporary folder found on one of the computer’s local drives. The 'Temporary Folder' specified WILL NOT be 

the output folder used for the final export. The specified ‘Temporary Folder’ is simply a directory with free space which can 

be used to speed up the processing of raster-based exports. 

 

Once the user has specified a temporary folder, MARS® will verify that there is enough space in the temporary folder to 

use in processing and the results will be shown in green below the ’Temporary Folder’ browse box. As long as the 

‘Required Space’ amount is less than the ‘Free Space’ amount shown, the computer will use the local folder for 

processing.  NOTE:  Most versions of Windows restrict an application's output of files to the root directory of 

drives.  It is strongly recommended that a sub-folder be used for this option. 

 

  

 

b. Batch Process Tiles: 

The ‘Save to Local Option’ may also be used in conjunction with the Batch Process Tiles tool. The option works the same 

way in this interface as it does in the export interface - it speeds up performance by using temporary local disk space 

during processing. To use this option, check the ‘Use temporary local disk space to speed up processing’ check box 

and designate a temporary folder found on one of the computer’s local drives. The 'Temporary Folder' specified WILL 

NOT be the output folder used for the final output files. The specified ‘Temporary Folder’ is simply a directory with free 

space which can be used to speed up the batch processing. Once the user has specified a temporary folder the computer 

will verify that there is enough space in that folder to use in processing and the results will be shown in green below the 

’Temporary Folder’ browse box. As long as the ‘Required Space’ amount is less than the ‘Free Space’ amount shown, the 

computer will use the local folder for processing. 
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15. Save/Load XML Settings 
a. Export: 

Another way to improve performance in MARS® is to use the ‘Save Settings to File’ and ‘Load Settings from File’ 

options found in the ‘Export’ interface.  The ability to save export settings will allow the user to make several separate 

exports with the same settings much more quickly than entering the setting specifications separately for every export and 

eliminates the possibility of typos. To use this tool, simply open the Export or Export Area interface and enter the 

parameters for export. Click on the ‘Save Settings to File’ button, navigate to the location in which the settings will be 

saved, name the XML file, and choose ‘Save’. Now that the settings have been saved, the user may exit MARS® and 

when another MARS® session is started, the ‘Load Settings from File’ option will allow the user to navigate to the folder 

which contains the previously-saved XML file and load it into the MARS® export application. 

 

b. GeoCalc: 

The ‘Save Settings to File’ and ‘Load Settings from File’ options are also found in the ‘GeoCalc’ interface. They 

function in the same way as for ‘Export’ (above). 
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 c. Batch Process Tiles: 

The user can create or edit multiple macro filters using the ‘Create/Edit Batch Script’ tool. To use this tool, go to the 

Edit/Filter Tab and click the ‘Create/Edit Batch Script’ button. The ability to save the specifications inside this interface 

allows the user to perform a particular macro filter or auto filter multiple times without having to enter the settings for the 

filter into the interface each time. The ‘Save as’ option, found inside the ‘Create/Edit Batch Script’ interface, functions very 

similarly to the ‘Save Settings to File’ tool inside the export dialog. Simply enter parameters for the batch script by adding, 

editing, or deleting filters and/or extraction tools within the macro. When all entries are complete, click the ‘Save as’ 

button. Navigate to the location in which the settings will be saved, name the XML file, and choose ‘Save’. Now that the 

settings have been saved, the user may exit MARS® and when another MARS® session is started, the user may choose 

the ‘Browse’ button located to the right of the ‘Existing Batch Script File’ browse box and navigate to the folder which 

contains the previously-saved XML file and load it into the MARS® Create/Edit Batch Script application. Any XML batch 

script that has previously been created can be loaded into MARS® with the ‘Load Batch Script’ option. To use this option 

go to the Edit/Filter Tab and click the ‘Load Batch Script’ button. Browse to the folder which contains the desired XML file, 

choose it, and click 'Open' to load it into MARS®. Once a batch script is loaded using this tool, it can also be edited. Upon 

loading the batch script, it will become an option in the Filter Action drop-down box. Use the drop-down arrow to choose 

the desired macro if more than one exists within the batch script. 

 

d. ‘Breakline Properties’ Window: 

This tool is for use with breaklines. Any breaklines which can be loaded into MARS® or are created in MARS® can be 

edited to fit the user's needs. With this interface, the user can change the color and description of any breakline type, 

determine which features will be displayed, insert new features, rename features, and even load an already existing XML 

template with custom features, colors, and codes. In the Compilation Options section of the interface, the user can search 

for points to use in elevation calculations, delete certain breakline classifications, and change the distance between points 

in a segment of a breakline, among other options. 
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16. ‘Auto Calculate Virtual Tile Size’ Grid Export Option 

Virtual tiles are used by MARS® to allow processing of manageable data sizes in RAM. A computer with less RAM needs 

smaller virtual tile sizes to complete an export while a computer with more RAM can process faster by using larger virtual 

tile sizes. An optional 'Auto Calculate Virtual Tile Size' checkbox is available to optimize internal processing based on a 

combination of average point density, available RAM, and the number of threads to be used during the export. 
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17. Fast, Compressed JPEG 2000 Raster Exports 
a. Flightline Separation: 

This tool functions similarly to the 'Color by Z Delta' tool and creates a JPEG 2000 as the output product. Having a fast, 

compressed raster export type such as JPEG 2000 can increase display speed and productivity. This export type is 

intended for use over an entire project area. The *.jp2 that is generated is based on the relative height differences 

between LiDAR data in overlapping areas. The overlap area differences are color coded, allowing the user to immediately 

detect relative vertical accuracy problems. The non-overlapping areas will show Intensity gridded data for reference 

purposes only. This tool is useful for rapidly assessing the consistency of the LiDAR dataset's height and is highly useful 

in boresighting. Over hard surfaces (such as roads) the user can expect the vertical height within the same ‘cell’ to be the 
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same regardless of the LiDAR collection scan from which the data originates. Differences are an indicator of a potential 

mission anomaly (typically a GPS/IMU problem) or a post-processing data adjustment issue. In areas such as forests or 

fields, where vegetation growth varies according to the time of year, understandable error may be seen. Lastly, the 

overlaid collection scan separation coloration will have a transparency set to it so that the output raster will still have some 

feature definition visibility. A multi-threading capability is available for this tool which will increase the rate of JPEG 2000 

production. Ideally, there should be a minimum of three (3) GB of RAM available (not just installed) per thread for best 

performance. 

 

Example: The raster shown below was created by exporting to a JPEG 2000. Collection scan overlap is represented by 

the colored sections of the raster. The colors are rendered based on collection scan separation using the ‘Color Options’ 

button on the ‘Grid’ tab. There is a cross scan included in this example which runs horizontally rather than vertically. The 

areas with no overlap are rendered by intensity value only.  

 

 

 
b. Hillshade: 

This tool allows the user to create a hillshade image or raster from gridded elevation float grids (*.flt). It is important to 

understand that the output file created by this tool is a raster. It is meant to display quickly, similar to the performance of a 

compressed ECW file. Because the resulting file is a raster file, this type of file will only work in 2D (orthographic) view 

and CANNOT be viewed in 3D. An image file, such as a JPEG 2000, acts similarly to a compressed ECW file and is much 

faster to display when using the pan, zoom in, or zoom out features than a float grid file would be. For a temporary 

hillshade rendered from a float grid(s), click on the ‘Color by Hillshade’  button. Display is much faster when the 

hillshade is exported as a JPEG 2000 however. 

Below is a sample of an exported ‘MARS_Sample_Data_Hillshade’ JPEG 2000 file. Because the resulting file is a raster, 

panning and zooming is much quicker than when using the corresponding Esri float grids with the hillshade created ‘on 

the fly.’ 
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c. LiDAR Spatial Distribution Verification GRID Tool: 
This tool is used to create a grid with values representing the presence (value = 1) or void (value = 0) of a first (of any) 

return LiDAR point within any portion of a predefined grid cell size. This tool creates a JPEG 2000 file as the final product. 

Having a fast, compressed raster export type such as a JPEG 2000 can increase display speed and productivity.  

The development criteria for this tool were based upon the USGS LiDAR Base Specification Version 1.0 (Techniques and 

Methods 11-B4), as currently stated:  

 

'The spatial distribution of geometrically usable points is expected to be uniform. Although it is understood that lidar 

instruments do not produce regularly gridded points, collections should be planned and executed to produce a first-

return point cloud that approaches a regular lattice of points, rather than a collection of widely spaced high density 

profiles of the terrain. The uniformity of the point density throughout the dataset is important and will be assessed 

using the following steps: 

• Generating a density grid from the data with cell sizes equal to the design NPS times 2, using a radius equal to the 

design NPS. 

• Ensuring at least 90 percent of the cells in the grid contain at least one lidar point. 

• The assessment is to be made against individual (single) swaths, using only the first-return points located within the 

geometrically usable center portion (typically 90 percent) of each swath.  

• Excluding acceptable data voids previously identified in this specification. 

Note: This requirement may be relaxed in areas of substantial relief where it is impractical to maintain a consistent 

and uniform distribution. 

Note: The process described in this section relates only to the uniformity of the point cloud distribution. It in no way 

relates to, nor can it be used for the assessment of point density or NPS.' 

 

Below is an example result of the ‘LiDAR Spatial Distribution Verification GRID’ tool. The green areas represent cells with 

a value of ‘1’, meaning they have at least one LiDAR point within the cell. The red areas represent cells with a value of ‘0’, 

meaning they DO NOT contain any LiDAR points. In the example below it is easy to see that there is a body of water running 

through this area, which is the cause of the red cells with a ‘0’ value. If the user were to implement the 'Minimum Zero Count' 

option when running this tool, the areas of contiguous ‘0’ cells (the water body) would return a null value instead of a ‘0’ 

value.  
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The 'LiDAR Spatial Distribution Verification GRID' tool will also output a results text file (*.txt) every time the tool is used. 

This file will be output to the same location as the JPEG 2000 (the location specified by the user in the output directory 

browse box). The text file will be named beginning with the date, time, and 

‘…LiDAR_Spatial_Distribution_Verification_Results.txt’. This allows each *.txt created to be unique. For instance, the file 

seen in the screen shot below was produced on February 2, 2011 at 2:45 pm. 

 

 

 

The text file will contain the following information: the number of cells with a ‘0’ value, the number of cells with a ‘1’ value, 

and the number of value ‘1’ cells as a percentage of the total number of cells. This last value will be the percentage of 

passing cells. This percentage needs to be 90% or above to be in compliance with the USGS specifications mentioned 

above. The screen shot below shows an example of the information contained in the text file. 

 

 

 

d. LiDAR Raster JPEG 2000 export: 
This tool is used to create a fast-exporting and fast-rendering JPEG 2000 raster from the loaded LiDAR data.  The raster 

cells can be colored by Class, Intensity, Elevation, or RGB values. 


